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1. Introduction

This document is a hands-on guide for MOLGENIS application development.

1.1. Why MOLGENIS?

Relational (SQL) databases" are the workhorses of most structured data management around the
world. However it still takes surprisingly amounts of effort to design and implement a full database
application. The MOLGENIS? platform allows you to automatically generate rich database
software to your specifications, including web user interfaces to manage and query your data,
various database back ends to store your data, and programmatic interfaces to the R language

and web services.

You tell MOLGENIS what to generate using an data model and user interface model described in
XML; at the push of a button MOLGENIS translates this model into SQL, Java and R program
files. Also documentation is generated. While the standard generated MOLGENIS is sufficient for
most data management needs, MOLGENIS also allows you to plug in handwritten software

components that build on the auto-generated software platform.

1.2. What will you achieve with this guide?
This guide can be used in a walk-through fashion to learn how:
e To model rich data models using MOLGENIS data definition language
e To generate your own customized MOLGENIS databases from scratch
« To generate a MOLGENIS to access existing databases
* To enhance the standard generated MOLGENIS with your own Ul plug-ins

« And how to automatically manage and retrieve your data using the Java, R and
SOAP interfaces

This guide assumes minimal Eclipse, Java and database experience; if not we suggest to team

up with someone who does.

' For example MySQL http://Awww.mysgl.org, Postgresql http://www.postgresgl.org, Microsoft SQL server

http://www.microsoft.com/sglserver/, Oracle http://www.oracle.com/database

2 Swertz & Jansen:Beyond standardization: dynamic software infrastructures for systems biology. Nature Reviews

Genetics 8: 235-243; Swertz et al: Molecular Genetics Information System (MOLGENIS) alternatives in developing local

experimental genomics databases. Bioinformatics 20: 2075-83; http://www.molgenis.org




2. Getting started

This section explains what you need to get started from a clean OS install up to the point where

you can generate, run and browse the MOLGENIS example that is shipped with the MOLGENIS

distribution (in the next chapter).

2.1.

Install the necessary software (only once)

MOLGENIS is known to run happily at Windows, Linux and Mac. We here assume the procedure

for the windows installation; for other operating system distributions we refer to respective

documentations. To get started, download and install the most recent:

1.

Java >= 6 JDK http://java.sun.com/javase/downloads/

Just install the most recent standard JDK from Java itself, with standard options.

Tomcat >=6 web server http://tomcat.apache.org/

Rember the root password you are asked. Don't run Tomcat as a service; we will start

and stop it ourself.

MySQL >=5.5 database server http://dev.mysqgl.com/downloads/mysql/

During installation of the Windows version you need to tick ‘innodb'. Remember your root

password!

Eclipse Integrated Development Environment 3.7 http://www.eclipse.org/downloads/

You need to install the J2EE version (which allows you to start/stop Tomcat).

Using Help > Eclipse Marketplace, install the Subclipse and JBoss Tools (Indigo) plugins.
On Linux systems, you may have to install JavaHL to get Subclipse working. From JBoss,
you only have to select the FreeMarker IDE (although it's OK to install the other ones as

well).

(Optional) MOLGENIS autogenerates documentation for your application. This requires

the GraphViz package from http://www.graphviz.org/Download.php

Make sure your PATH is set to run 'dot.exe’ from the commandline. In Windows this is set

in the control panel -> System -> Environment variables.



2.2. Setup a MySQL database (once per MOLGENIS instance)

MOLGENIS typically uses MySQL as data storage back-end although also HSQL or PostgreSQL
may be used. Here the procedure for MySQL is described to create a database and give

MOLGENIS permission to populate it.
6. Open the mysql executable as root user.
Under Windows: "C:\Program Files\MySQL Server 5.5\bin\mysql.exe - u root —p
Under Linux/Mac: “mysqgl —u root -p”
Type your MySQL root password remembered from step 3!

7. Create a database 'molgenis' and provide rights to the molgenis generator to change it

using password 'molgenis'. Type:
create database molgenis;
grant all privileges on molgenis.* to molgenis@localhost identified by 'molgenis’;

flush privileges;

2.3. Make your MOLGENIS workspace using Eclipse and SVN
Most application developers use Eclipse to develop MOLGENIS applications.

8. Choose File > New > Other... In the box that pops up, choose SVN > Checkout Projects

from SVN. Create a new repository location: http://www.molgenis.org/svn. Click the

‘molgenis’ folder and choose ‘trunk’. Then click Next, Next, Finish. All the default settings
are OK.

9. Repeat the procedure at 8 to check out the ‘molgenis_distro’ trunk. This time you can use

the existing repository location.



3. Generating the distro MOLGENIS application

In this chapter you will learn to generate a MOLGENIS database application using Eclipse. First

you will check the MOLGENIS workspace, then you will get acquainted with the generator tools

and finally you will generate, compile and run your first MOLGENIS application.
Before you start — ensure that you have at least from the previous section:
Java Development Kit 6 or higher
A Tomcat server instance
A MySQL database
Eclipse IDE including J2EE extension, Subclipse and JBoss FreeMarker IDE

Eclipse workspace with molgenis and molgenis_distro checked out

3.1. Checking the MOLGENIS workspace
In this section you will verify your workspace:

1. Start Eclipse. You will see in the left pane:

riv v Qv Qv
[’ Project Explorer &3 s
e bz

» o4 molgenis [molgenis/trunk]
» *< molgenis_distro [molgenis_disti

The workspace contains two projects: (a) molgenis contains all code of the

MOLGENIS framework (b) the project molgenis_distro contains an application

template which you will use to create the new MOLGENIS application with.

2. Check whether MOLGENIS is properly linked with Java: Right-click on the molgenis

and choose [refresh]. Then right-click on the molgenis_distro project and choose

[refresh]. This will force Eclipse to rebuild the code for your platform.

2 Refresh



If everything is well then there will be no errors listed in the problems pane on the

bottom of your screen.

(% Problems 2 ¥ Tasks | 2

0 errors, 455 warnings, 0 others (Filker
Descripkion
£ Warnings {100 af 455 itemns)

3. (Skip step unless library issues). To link missing system libraries choose [Window] ->
[Preferences]. Then browse to Java -> Installed JREs. Finally add your JDK and tick to be

used as default.

4. Open the molgenis_distro project and [ Project Explorer 53 5 & - =7
explore. This unveils the basic MOLGENIS | » i generated -
application structure: 'fzig\?”mn

¢ molgenis.properties contains P"Fﬂ;rmmmands
» G META-INF
the settings of your applications. Exorg
b i plugins
e« The *xml files contain your Bl log4j.properties 5833 11/24/104:58 PM

[} MolgenisExtrackModel.java 2304 9/23/0
) MolgenisGenerate.java 3038 6/17/102:0

l

MOLGENIS models

) 11 MolgenisUpdateDatabase.java 3038 6/1
*  WebContent contains web ) README.EXt 2066 8/1/02 7:35PM m

resources (images, javascript, etc) ¥} testng.xml 3017 6/16/10 10:52 PM msw
» 7 WebContent

&3 build.xml 8514 8/4/11 10:56 AM mswertz
¥4 example_db.xml 3707 10/11/10 8:36 PM mc
generated/sql will contain the ¥ molgenis_auth.xml3519 5/16/10 3:

2:19 PM eri £
output of the MOLGENIS generator. 2:19 PM eril

e generated/java and

4¥3 molgenis_db.xml 8732 &

¥ molgenis_ui.xml 7115 4:33 AM msw| ||€

[B molgenis.dtd 1980 &/18/09 5:56 PM mswerl

¢ handwritten/java contains the ! : L SR
[5 molgenis.properties 8732 8/23/112:19 PM A
MOLGENIS generator tools and any B molgenis.test.properties 5839 11/24/109:5_{|
. [8} molgenis.xsd 1980 6/18/09 5:56 PM mswe |
programs you will add. - d =13

ki 74 molgenis_distro



3.2. Running the MOLGENIS generator

In this section you go through the basic procedure of generation, compilation and running of a
MOLGENIS application.

1. Run the MOLGENIS generator: right-click on the MolgenisGenerate.java program and

choose ‘Run as....run as Java Application:

 tRumonsorver Aksshite, R

Debug As 2 Java Application  Alt+Shift+, )
Profile As
Validate Run Configur ations. ..

The MOLGENIS generator parses the *.xml files to read in the model and
subsequently translates the model in many Java, SQL and R files that end up in the
folder generated/java and generated/sql. All this will be printed to the console. Scroll

through the console to get a feel for what has just happened:

[2 problems [ ¥ Tasks | 5] Properties | 4L Servers | B Data Source Explorer | [ Snippets | B console &2
<kerminated = MolgenisGenerate [Java Application] C:A\Program Files) Javaijdkl 6,0_13bintjavaw, exe (24 mei 200
1206 WALERN [PluginfcreendavaTemplateGen] 3kipped bhecause exists: hanc
1206 WALERN [PluginfcreendavaTemplateGen] 3kipped bhecause exists: hanc
1906 INFO [MolgeniszServletContextGen] generated WebContenth METL-TIHNFS
1937 INFQ [SosplpiGen] generated generated) javahexample’ Ioaplpi. jave
1953 INFQ [CsvImporticen] generated generated) javahexasmpleh toolshCavl
1968 INFO [CavExportGen] generated generatedhjava’exampledtoolsh CavE
2000 INFO [CavImportByNamesen] generated generatfyy javahexampleh tool
Z015 INFO [CopyMemoryToDatabasesen] generated generated’ java’ example

2. Run the MOLGENIS database updater: right-click the MolgenisUpdateDatabase.java
program and choose Run as....Java Application. This will load
generated/java/create_tables.sql into mysqgl database based on the settings in

molgenis.properties

t Praoblems |+ Tasks | = Properties | #1b Servers Data Source Explorer | [B=5 Snippets El consale 52

<terminated = MolgenislpdateDatabase [Java Application] C:\Program FileshJavaljdkl.6.0_13bintjavaw exe (24 n
u] DEEUG [MolgenisOptions] parsed properties file.

375 DEBUG [main] wusing file generatedssaoglh create tahles.sgl

375 INFOQ [mwain] Updating database. ...

1234 INFO [main] MOLGENIZ datsbase updated succesfully

10



Compile the generated application: right-click on the molgenis_distro project and choose

[refresh]. This will force Eclipse to discover and compile the code you just generated.

Run the application: right-click on the molgenis_distro project and choose [Run as...] ->

[Run on server].

Notice: on the first run this may open a dialog, asking you to define a new server.

Choose Tomcat of your version and choose Next to point it to the right directory.

& Run On Server

Run On Server

Select which server to use

How do wou want to select the server?

(:} Choose an existing server

%) Manually define a new server

Server's host narme:®| localhost J

Download additional server adapkers

Select the server bype:

|t~:.-'|:ue Filker bext [

3

== ppache
B Tomcat v3.2 Server
Tomcak w4.0 Server
Tomcak w4.1 Server
Tomcat ¥5.0 Server

| [EE] ] ) 2

= —

Tomcak ¥5.5 Server

L

[*- (52 Basic
Publishes and runs JZEE and Java EE Web projects and server configurations to & local Tomcat
SEryer,

[l

Server name; | Tomcat wa,0 Server at localhost (2) [

Server runtime environment: |.ﬂ.pache Tamcak v&.0 " ! Add...

Configure runkime environments., ..

[ ] &hways usethis server when running this project

"ZTZS' < Bach | Next}- [ Finish H Zancel

11



5. Finally browse the generated result and test the result by adding data:

& el | http:/{localhost:8080/molgenis_distro/molgenis.do

My MOLGENIS

Experiments
File »Edit +View » 44 €4 1of 1 pp pp|

Experiments

[ﬂugmw W =] search: |
l-s:nnrtphgin
id 1 |
Name Itesl: |
Description
4
CreationDate *|E| ﬂ " Z

Samples }m{ ,ﬁ ng]

Samples

File »Edit « View » |4d 44 DO-00f 0 pp pp|

L0

i 7 caarch: |

See that you get a rich set of user tools ‘for free”:
- change the view from listview to recordview to editview
- add/update/remove one or, in listview, multiple records
- search for particular elemements
- view the object model under the ‘object model link’

- view the R and SOAP interfaces (to be discussed later)

12




4. Creating a MOLGENIS from scratch

In this chapter you will create a new MOLGENIS application from scratch using Eclipse. You will
use the example of a simple Address Book application: a simple database having “Contacts”

entities that each can have zero or more “Addresses”.

The data model and user interface produced will look like:

My Address Book

| About | Obiect model | B-project APl | HTTF AP | Web Senvices AP

Contacts
Contact
o file Edite Views |44 44 1071 Bb bb|
L
contact_id ; int . - I—I 3
dizplay : string E? Ij search; contact d v[= ]| :'k\.
lastname ; string contact_id 1
firstname : string display Marris
midinitialz ; string
lastname !
hirthcay © date Swertz
firstname Maorris
midinitials 2
kirthd
marly 1 ay  March 13, 1976
Address Addresse
address_jd ; int £ L £ 0
phone © string
addres=_type : enum -
cortact_jd - xref(Contact) B (g, [ searcniaddessid - v N |
address_id ¥ phone address_type contact_id
1 +31(0) 50 361 7100 work Marris
6| O
O
* = this record is readonly.

Before you start — ensure that you have at least from the previous sections:
Learned how to compile, generate and run a MOLGENIS application
Learned how to setup a MySQL database with proper privileges

We also assume basic knowledge of XML and relational database modeling.

13



4.1. Create the data model

1. Create a new xml file ‘addressbook_db.xml ' in the root of you application. This file will

contain the MOLGENIS model. Use the following template:

<?xml version ="1.0" encoding ="UTF-8"?>

<molgenis

name="addr essbook" >

</ molgenis >

Now we will step-by-step build the XML model. A useful tip:

« If you use the key combination ‘ctrl+shift+f’ then Eclipse will automatically layout the XML

file.

For a complete description of all XML elements allowed we refer to section 10.

2. Add a “Contact” data type. Data types are called ‘entity’ in MOLGENIS. Type:

<molgenis name="addr essbook" >

<entity name="Cont act " >

</ entity >

</ molgenis >

3. Add properties to the “Contact” data type. These are called ‘fields’ in MOLGENIS. Add within

the entity element:

A unique, automatic numeric identifier field that MOLGENIS will use to refer

contacts.

<field name="cont act i d" type ="autoi d"/>

A required and unique string field ‘displayname’ to have a unique label to find

Contacts by. Note that if you provide no ‘type’ then type="string” is implied.
<field name="di spl aynanme" unique ="true"/>

Optional (‘nillable’) string fields for firstname, lastname and midinitials:

<field name="fi r st name" nillable ="true"/>
<field name="m di ni ti al s" nillable ="true"/>
<field name="1| ast nane" nillable ="true"/>

An optional field of type date for birthday:

<field name="bi rt hday" type ="date" nillable ="true"/>

4. Similarly create a “Address” data type (to keep it simple we only do phone numbers):

14



<entity name="Addr ess" >

e A unique, automatic numeric identifier field that MOLGENIS will use to refer

addresses.
<field name="address_i d" type ="aut oi d"/>
* Add the phone number field:

<field name="phone" />

* Add a field where the user can choose from an enumeration of options whether
the address is ‘home’,’'work’,or ‘mobile’:

<field name="addr ess_t ype"
type ="enunt enum_options ="[hone, wor k, nobi | e] " />

5. Finally we need to link the Addresses to each Contact. In relational databases this is done
using the mechanism of a ‘foreign key’. In MOLGENIS fkeys can be defined as follows:
< field name="cont act" type ="xref"
xref_field ="Cont act . contact _i d"

xref_label ="di spl aynane" />
</ entity >

Note that the xref_field refers to unique field ‘contact_id’ in entity ‘Contact’. The
xref_label attribute indicates that we want to view references to Contact by

‘displayname’ name instead of the numeric id.

Use of a meaningless numeric ‘id’ next to a meaningful ‘label’ enables us to
change the ‘displayname’ name on Contact without the problem of also having to

change this on each Address that refers to this contact.

15



4.2. Create the user interface model

6. Create a new xml file ‘addressbook_ui.xml " in the root of you application by copy-pasting

the db.xml file. This file will contain the MOLGENIS user interface model.

7. We want to show the list of Addresses nested per Contact; for MOLGENIS you simply
express this by nesting form elements. If suitable ‘xrefs’ exists these will be used to tie
container and nested form together:

<?xml version ="1.0" encoding ="UTF-8"?>
<molgenis name="addr essbook" >

<plugin name="nol geni s_header"
type ="pl ugi ns. header. Mbl geni sHeader" />

<form entity ="Contact"” name="Cont acts">
<form entity ="Address" name="Addresses" view ="list"/>
</ form >

</ molgenis >

4.3. Generate the new MOLGENIS application

8. Open the molgenis.properties file. The model_database and
model_userinterface options point to the XML files where a data model and user
interface is specified. Change to point to our newly created addressbook_db.xml and
addressbook_ui.xml files

HEHEHH R S R T HEHEHHH T
# 1. FILES DESCRIBING YOUR DESIGN USING MOLGENIS XM L LANGUAGE
# can be multiple files ', separated

HEHEHH R S S T HEHEHHH T

# xml file with data model in terms of 'entity’ descript ions
model_database = addressbook_db.xml

# xml file with user screen descriptions in terms of 'fo rm',
‘menu’,..

model_userinterface = addressbook_ui.xml

9. Create a new mysql database instance named ‘addressbook’ as you learned in section 2.2.
Then edit molgenis.properties file to connect to this new database instance (assuming
you used the same molgenis username/password again):

T A T A R T R R T T HHHTHTHR AR

# 2. DATABASE SETTINGS
e L L e ]

# MySQL:

#jdbc compatible connection parameters to a database (se e doc
of database supplier)

db_driver = com.mysgl .jdbc .Driver

db_user = molgenis
db_password =  molgenis

16



db_uri=  jdbc : mysql://localhost /addressbook

10. Finally, generate, compile, update database and run your application as you learned in

section 3.2.

[3_ Problems | = Tasks | = Properties | &1l Servers 3
Clean Tomcat Work, Directory. .

Server State Properties Alt+Enter

L+ a Tomcat v6.0 Server at localhost i Starked

NOTICE: if you don't see your newly generated MOLGENIS but instead a previous iteration,
go to the Servers screen and ‘Clean Tomcat Work Directory...”: a previous user session was
still in place. Should even that not work, then choose the ‘Clean...” option to fully clean the

server configuration.

4.4. Optional exercises

4.1 Expand the address book: add fields to register email address, physical addresses
(organization, street, zip code, city, country) and for city and country add additional entities

‘Country’ and ‘City’ and link these to the Address using xref fields.

4.2 Improve the address book application by using advanced features such as ‘hidden’ (for
automatic ids) and ‘label’ to create prettier field labels (for address_type). See reference section
10.

17



5. Creating a MOLGENIS for existing data

There is legacy of existing databases, many of which provide SQL dumps/TEXT downloads or
you may have a local database already of your own that you want to ‘molgenize’. In this section
you will learn how to generate a MOLGENIS for an existing database by automatically extracting
the MOLGENIS data model from it. Secondly, you will learn how to batch-load existing data sets

from delimited text files.
Before you start — ensure that you have at least from the previous sections:
Learned how to compile, generate and run a MOLGENIS application
Learned how to edit molgenis.properties to connect to a particular database

Loaded the MOLGENIS distro database in section 3.

5.1. Generating a MOLGENIS for an existing database

1. Edit the database connection settings in the molgenis.properties file to refer to an
existing database. See section 4.3, step 9. In this example it is assumed you connect to the
address book database from the previous section. Alternatively you can download a database

dump of your choice or connect to a remote database (assuming proper rights).

2. Run handwritten/java/MolgenisExtractModel.java. The extraction tool will
connect to your selected database and extract a model from its table structure. An example

console output for the address book application:

18



t Problems | 44 Tasks | ] Properties | &7l Servers | [ Data Source Explarer

B Snippets | & Console &2

::termlnated:b MolgenisExtractModel [Java Application] C:\Program Files)Javaljdkl .6.0_13bintjavaw. exe (24 mei

B s f Lt e SERL s et
<molgenis nawe="addresshook™:>
<entity name="address":>
<field name="address id" type="autoid"/ >
<field name="phone"/ />
<field name="address_type"f>

L AR i iy Sy i o far T

R

<field name="contact id"™ type="xref" xref field="contact.cont

</entityr

<entity hame="contactT>-
<field name="contact id" type="autoid"/ >
<field name="display" unigque="trus"/>
<field name="lastnams"/>
<field nillable="true™ name="firstname"/>
<field nillable="true™ name="widinitials"/ />

<field nillable="true™ name="birthday"™ type=

</entityr
<fmolgenis:s

"date"/ >

3. Copy-paste the parts of XML you want to use from the console into your *_db.xml file. Then

add a suitable *_ui.xml. Then adapt the molgenis.properties

file accordingly and

generate, compile, run to view the results (as learned in the previous section).

5.2. Batch loading of data

MOLGENIS also provides methods to quickly load large data sets from comma or tab separated

data, both in the Ul as well as in the Java API (as we will see in section 8). This works if:

e The column headers match the entity field definitions (order doesn’t matter).

* A special case are ‘xref’ data that either can use the xref field or the xref label. For

example in the case of address book ‘contact_id’ and ‘contact_displayname’.

4. Load data for Contact. Within the MOLGENIS user interface for Contacts choose ‘File’ and

then ‘Add in batch/upload CSV'.

Download visible (.txt)

+ Download all (.kxt)

+ Download visible (.xls)

+ Download all (.xls)

4 Add in batch/upload csv

+ Upload csV File

19



In the dialog that pops up, paste the following into the ‘CSV data’ field (leaving the
other fields blank):

displayname,lastname,firsthname,mid_initials,birthda y
Prof.dr. R Bischoff,Bischoff,Rainer,,

Dr. R Breitling,Breitling,Rainer,,

Prof.dr. RC Jansen,Ritsert,Jansen,C,

5. Load data for Address. In the dialog for Example data for Address again choose ‘File’ and
then ‘Add in batch/upload CSV'. Set the ‘address_type’ to ‘work’ as constant for all addresses

to be loaded (otherwise you get an error!). Then paste in the CSV data dialog:
phone,contact_displayname
+31 (0)50 3633338,Prof.dr. R Bischoff

+31 (0)50-3638088,Dr. R Breitling
+31 (0)50-3638089,Prof.dr. RC Jansen

Notice the cross-reference by ‘xref _label’ using ‘contact_displayname’!
5.3. Optional exercises
5.1 Connect MOLGENIS one of your own datasets or to one of the publicly available databases.

5.2 (For programmers) Write a simple script that, given a set of CSV files, produces a

MOLGENIS data model definition in XML.
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6. Creating a user interface plug-in

MOLGENIS plug-in mechanism allows you to add custom pieces of code to the generated user
interface. Here you will create a simple ‘Literature’ plug-in for the Address Book application that

shows this years list of publications from Pubmed for each contact.
Before you start — ensure that you have at least from the previous sections:
Learned how to compile, generate and run a MOLGENIS application

Completed the address book example as that is reused here

6.1. Adding the plug-in to the user interface
Firstly, we will add the plugin to the model:

1. Edit addressbook_ui.xml to add your plugin to the XML model; note how you can use

menu to group the Address next to the new ‘Publications’ plugin.

<?xml version ="1.0" encoding ="UTF-8"7?>
<molgenis name="addr essbook" >
<form entity ="Contact" name="Cont acts">
<menu name=" Cont act Menu" >
<form entity ="Address" name="Addresses" view ="list" />

<plugin  name="Publ i cati ons"
type ="pl ugi n. pubmed. PubnedPl ugi n" />
</ menu>
</ form >
</ molgenis >

When you now run the generator and refresh, an 'empty' screen plugin controller class
will be generated inside the folder handwritten/java (unless the file allready exists). In this
case a class file called pl ugi n. pubned. PubrmedPl ugi n. Next to that a layout
template is generated to layout the ~contents of your plugin in
pl ugi n. pubmed. PubmedPl ugi nView. ft1. This template is generated in the

FreeMarker template language, http://freemarker.sourceforge.net. A model class file

called pl ugi n. pubred. PubnmedPl ugi nMbdel is also generated, for storing the state of

your plugin.
Secondly, add the ‘model’ and ‘logic’ to the Java part of the plugin:

2. In the model class (plugin.pubmed.PubmedPluginModel.java ), just above the

constructor, create the properties to store the lastname and current year to be filtered on:

String  lasthame ;
String  year = "2011" ;
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3. Open the controller class (the plugin.pubmed.PubmedPlugin.java file from the

handwritten/java folder). You see it already has a few methods including:

5.

e ‘updateDate’, which is an example of a request handler, to process user requests

(updates, interactive features). You can delete this method as we will not use it.

¢ 'reload’, to implement what needs to be done if the page is reloaded (data loading).

Create the logic to produce a Pubmed query string. Edit the ‘reload’ section of the controller

as follows:

On reload, take the lastname from the Contact currently shown in the parent from and
update the model. Note: you will have to import java.util.List and addressbook.Contact
to get the code working. Hover over the error indicators with your mouse and choose the

appropriate import.
publ i ¢ voi d reload(Database db) t hr ows Exception

/lget the author name from parent from
FormModel<Contact> form =
t hi s.getParentForm(Contact. cl ass);
List<Contact> visibleContacts = form.getRecords() ;
getModel(). lastname =
visibleContacts.get(0).getLastname();

In the model class again, add an additional method to produce the query string for Pubmed:

publ i ¢ String getQueryString() {

String url = "http://www.ncbi.nlm.nih.gov/pubmed?term="
+ lasthame +"au]" ;
if(year '= null)
url += year +"[Publication Date]" ;
returnurl;

}

Finally, we will edit the Freemarker template (ftl) in order add a window to the user interface

layout in order to show Pubmed results based on our query string:

6.

Open the plugin/pubmed/PubmedPluginView.ftl file from the handwritten/java folder.
You see it already is a complete web page including a form. Edit the section between ‘begin’
and ‘end’ to create a view to pubmed as ‘iframe’ and using the querystring defined in the Java

plugin model. Note this Java object is referred to as ‘screen’:

<#--begin your plugin-->

<iframe src= " ${screen.getQueryString()}
width= "100%" height= "800px" >
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<#--end of your plugin-->

7. Refresh and run the application.

6.2. Handling user requests
In this section we will enhance the plugin with some interactive element.
1. Inthe model class, add a method to provide the ‘year’ to the view:

publ i ¢ String getYear()
{

return year ;

}

2. In the *.ftl file add inputs for the user to enter a ‘year’ and a submit button to send this
input’s value to the plugin’s Java controller class. Notice: within MOLGENIS it has become
practice to always use a field named ‘action’ to transfer the user intention. Hence the

‘onclick="__ action.value="setYear

mechanism. The controller's superclass has a method
to handle the request, extract the ‘action’ and call the controller's method with the same

name (in this case ‘setYear’).
<#--begin your plugin-->

<input type= "submit"  value= "Setyear:"

onclick=""__action.value='setYear™ / >
<input name="year" value= " ${screen.getYear()} ">
<iframe src= " ${screen.getQueryString()} " width= "100%" height= "800px" >

<#--end of your plugin-->
3. Inthe controller class, add the method to handle this new action input:
publ i c voi d setYear(Database db, Tuple request)

i f (request.getString( "vear" )=  null){
getModel(). year = request.getString( "year" );

}

4. Refresh and run the application.

6.3. Optional exercises
6.1 Extend the Pubmed plugin by including the use of firstname and initials to improve filtering.

6.2 First walk through section 9.1 to learn using the Java Database interface. Then create a new
plugin called ‘VCardAdd’ that enables you to add a new contact based on a VCard snippet. See

http://en.wikipedia.org/wiki/VCard.
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7. Creating a data validation plug-in

MOLGENIS allows you to add custom pieces of code to the database mapping components (that
is the piece of software that talks between MOLGENIS and the SQL database back-end). This
type of plug-in is called a ‘decorator’. You will use this decorator mechanism to validate the input

of email addresses and provide the user with an error message if needed.
Before you start — ensure that you have at least from the previous sections:
Learned how to compile, generate and run a MOLGENIS application

Completed the address book example as that is reused here

7.1. A data validator for email addresses

1. Extend the addressbook _db.xml model with an additional ‘email’ field on ‘Address’ and add

the decorator. Then regenerate and the decorator class
handwritten/java/decorators.AddressDecorator.java is auto-generated.
<entity name="Addr ess" decorator ="decorators. AddressDecor at or">

<field name="emi | " />...
</ entity >

2. Edit the decorator class handwritten/java/decorators.AddressDecorator.java for
email address validation on ‘add’. We naively say that an email address should have a ‘@’ in the

middle and if not we throw a ‘DatabaseException’:

@Override
publ i ¢ i nt add(List<E> entities) t hr ows DatabaseException
{

f or (addressbook.Address e : entities)

{
i f (e.getEmail() != nul | &&
e.getEmail().split( "@"). length '=2)
t hr ow new DatabaseException(
"Email address " +

e.getEmail()+ is invalid" );

/I here we call the standard 'add'
i nt count= super .add(entities);

ret urn count;

}
3. Update the database to add the new ‘email’ field to the Address entity (unfortunately, the

entries you've already added will be lost) and then restart your application to test your
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decorator. You don’'t need to regenerate/recompile: just select the ‘Servers’ pane and right-

click -> Clean Tomcat Work Directory...
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8. Intermezzo: learning SQL

MOLGENIS is built on top of SQL. For practical purposes it is good to learn SQL. Below there is a

series of exercises to get you started.
Before you start — ensure that you have at least from the previous sections:

Learned how to compile, generate and run a MOLGENIS application

8.1. SQL quick reference

8.1.1.General format

SELECT what_to_select
FROM which_table
WHERE conditions_to_satisfy;

8.1.2. Example Select:

SELECT * FROM pet;
SELECT name, birth FROM pet;
SELECT * FROM pet WHERE name = '‘Bowser’,

SELECT * FROM pet WHERE birth >=*1998-1-1’

SELECT * FROM pet WHERE species = 'dog' AND sex =" f's

Note: 'yyyy-m-d’ is the ANSI SQL format for date.

8.1.3.Table joins

SELECT pet.name,(YEAR(date)-YEAR(birth)) -
(RIGHT(date,5)<RIGHT(birth,5)) AS age, remark FROM pet, event WHERE
pet.name = event.name AND type = 'litter’;

SELECT pl.name, pl.sex, p2.name, p2.sex, pl.species FROM pet AS p1,
pet AS p2 WHERE pl.species = p2.species AND pl.sex ='f" AND p2.sex
= 'm"

There are other ways of combining tables involving so-called joins. Joins are more efficient, but

also somewhat more complex.

‘SELECT * FROM tablel INNER JOIN table2 ON tablel.id =table2.id;

8.1.4.MAX(), COUNT(), AVG()

There are so-called aggregate functions available. These include: max(fieldname) [get het

maximum], count(fieldname) [count the number of occurrences] and avg(fieldname) [compute the
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average]. They work based on a selection. The first example will give the number of rows in the
table. The second example shows the use of the GROUP BY statement: it gets the number of

pets per owner (effectively creating selections in selections, which can be counted).

SELECT COUNT(*) FROM pet;

SELECT owner, COUNT(*) FROM pet GROUP BY owner

SELECT article, MAX(price) AS price
FROM shop
GROUP BY article

8.1.5. Distinct

SQL will return all records that match the criteria, often leading to multiple instances of the same

rows. DISTINCT will filter these for you.

\SELECT DISTINCT owner FROM pet;

8.2. Query exercises with expected output

An example data model ‘biomaterials’ is used, its structure summarized below.

Location Crwiner
I_no: int o_no: int
name : string name : string
temp : int functian : string

= e
miaky majy
Biornaterial

b_no: int
description : text
weight © int

tox : bool

created : date
owner - xrefiCwner)
lacation : xrefillocation)

The accompanying datasets used here are available for download as mysql ‘dump’:
1. Open mysgl.exe command line interface as root user.
2. Load and use the example data set using commands:

create database biomaterial;

use biomaterial;
\. <pathto>/biomaterial_dump.sq|

Now you can start typing sql queries for the following cases:

3. Which biomaterials were created before 2003?
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b_noldescriptionjweight|tox|created owner|location
676 1248 |1 [2002-12-14 00:00:00.0{10 |26

687 714 |1 |2002-12-22 00:00:00.0|7 22

709 807 |1 |2002-12-28 00:00:00.0111 |29

725 1133 |0 [2002-12-10 00:00:00.0|7 1

774 1190 |0 [2002-12-14 00:00:00.0|1 5

4. Which students have been working with toxic biomaterials?

name
Sukke Lee
Boris Lee

Sarah Finn
Peter Finn

5.  Which owners have biomaterials larger than 1000 grams in —80 C storage locations

name
Sukke Lee

Sarah Jones
Sukke Becker
Susan von Svede
Sukke von Svede
Boris Jones

Boris Smith

Peter Smith

Boris Finn

8.2.1.Using database functions

4. What was the total weight of the stored biomaterials created in 20037

sum(weight)
56258

5. What was weight of the biggest sample stored in —80?

max(weight)
1471

8.2.2.Using group by/having

6. What is the total weight of biomaterials per owner?Give the average weight of toxic
biomaterials per location?

29



name sum(weight)
Boris Finn 3982
Boris Jones 5305
Boris Lee 5480
Boris Smith 4846
Fokke Becker 3680
Fokke Smith 5848
Fokke von Svede|3769
Martin Finn 1432
Martin Smith 1535
Martin von Svede|3295
Peter Finn 4517
Peter Smith 8091
Sarah Becker 4402
Sarah Finn 2331
Sarah Jones 10990
Sarah Smith 2837
Sukke Becker 10772
Sukke Lee 7989
Sukke von Svede|3385
Susan Becker 2490
Susan Jones 1525
Susan Lee 702
Susan Smith 6451

Susan von Svede

6239
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9. Using the programmatic interfaces

The MOLGENIS framework provides programmatic access from Java, R and SOAP so you can

use MOLGENIS as part of your statistical and/or work flows..
Before you start — ensure that you have at least from the previous sections:

Completed the Address Book example as that is reused here

9.1. Using the Java interface

Java access to MOLGENIS is via a ‘Database’ class. This class provides efficient methods to
add, update, remove, find and count data inside your MOLGENIS either one-by-one or in an

efficient batch modus:

1. Using the ‘Database’ interface: In the Address book application, create a new Java class file

in handwritten/java as follows and then Run as ... Java application (watch the console):
i nport org.molgenis.framework.db.Database;
i mport app.DatabaseFactory;
i nport addressbook.Contact;
i mport addressbook.Address;
public cl ass TestDatabaseApi {

public static void main(String[] args) t hr ows Exception {

Create a database from the properties file:

Database db = DatabaseFactory. cr eat e( "molgenis.properties" );

List all contacts:

f or (Contact c: db.find(Contact. cl ass))
{

}

System.  out .printin(c);

Add one object to the database:

Contact one = new Contact();
one.setDisplayname( "testone" );
one.setEmail( "test@test.nl" );

db.add(one);
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Add many obijects to the database using the same method:

System. out .printin( "Add many contacts:" );
List<Contact> many = new ArrayList<Contact>();
for(int i=0;i<10;i++)
{
Contact c = new Contact();
c.setDisplayname( "simulation” +i);
c.setEmail( "simulation” +i+ "@test.nl" );
many.add(c);

}
db.add(many);

Observe that ‘many’ now also has the autoid column set:

f or (Contact c: many)

{
}

System.  out .println(c);

Finally, remove all the data you just added:

System. out .printin( "Remove contacts:" )
db.remove(one);
db.remove(many);

2. Using the ‘Query’ interface. Extend your class above with the following to query. Notice you

[}

can just add more criteria using the ‘.’ notation:

Query<Address> g = db.query(Address. cl ass);
q.like( "displayname" , "B");

f or (Address t : g.find())
{

System.  out .printin(t);
}

3. Using the ‘sql’ interface. Extend your class above to directly use SQL.:

List<Tuple> result = db.sql(
"select * from contact where displa yname like '%B%"™ );
f or (Tuple t: result)

{
System.  out .printin(t);
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9.2. Using the R interface

On the MOLGENIS user interface there is a link to the R interface. If you read this we is assume

that you already installed R from the http://www.r-project.org web page.

5. Start the MOLGENIS server for your Address Book application and browse to the user

interface.

6. Click the ‘R-project API' pagelink on the top menu of your Address Book and view and copy
the R script that is shown on this page. Notice how the R-api is simply an ‘source.R’ file on
the MOLGENIS server.

7. Start the RGui and paste the R script you just copied. (Optional) you may get an error that the
RCurl package is unavailable. In that case uncomment and paste the following lines to install

this package:

source("http://bioconductor.org/biocLite.R")
#biocLite("RCurl")

8. Finally reproduce the java script listed above. The first part is already given below:
find.contact()
add.contact(displayname="test")
find.contact()

remove.contact(find.contact(displayname="test"))

9.3. Using the SOAP interface in Taverna

On the MOLGENIS user interface there is a link to the SOAP interface for web services. Here we
will show how to use web services to access the data from Taverna. If you read this we is

assume that you already installed Taverna from the http://www.taverna.org.uk.

9. Start the MOLGENIS server for your Address Book application and browse to the user

interface.

10. Click the ‘Web Services API’ pagelink on the top menu of your Address Book and view and
copy the hyperlink http://..... api/soap?wsdl. Note: a WSDL file is a standard description

format of web services in the SOAP protocol.

11. Start Taverna and add the WSDL to Taverna using the WSDL scavenger as shown in the

screenshot below.
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¥/ Taverna Workbench v1.7.1.0

File Tools Workflows  Advanced

|._.£5 Design| B Results @ Taverna 2 preview

Search | | ¥ Watch loads
M Available Processors
#-5 Loca

HaWSD @ Add new API Consumer,.,

W3 WSO s Add new Biomart service...

j ﬁgg W idd new Biomoby scavenger...
N

= Biarr g dd new Soaplab scavenger..,
-3 Soar :

h- new Work flow scavendger...

12. Assuming you experienced Taverna user explore the usage of the services added. Otherwise

we recommend to follow a Taverna tutorial first. Hint: use ‘splitters’ to ease the adding of

parameters. Note: update and remove services have been disabled in the standard

MOLGENIS distro.

= WSDL @ http:/flocalhost: 2080/ molgenis/api/soap?wsdl
(= porttype: Soapapi [DOCUMENT ]

""" o getiddress

""" @ findContact

----- s findContacttsy
----- o getContact
----- w? findéddressCsy

9.4. (Experimental) generate an RDF/Sparql interface using the D2R server

13. Download and extract D2R from http://www4.wiwiss.fu-berlin.de/bizer/d2r-server/.

14. Generate a mapping file for your database schema. Change into the D2R Server directory

and run the following command (one line — no enter, under Windows use the .bat file):

./generate-mapping -u molgenis -p molgenis -0 mapping.n3
jdbc:mysql://localhost/addressbook

15. Start the server (under Windows use the .bat file):

.Jd2r-server mapping.n3
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16. Test the Server: Open http://localhost:2020/ in a web browser.

o= ‘Start Page | D2R Server =
m:'_ El. 1 ﬁ http: flocalhost-2020/ ".-i-_q.' Cite

D2R Server o
Running at hitp:ilocalhost-2020/

Home | conlerances organizaiions papers pamons ml paner lopic lopics

This s a database published with D2 Server. Il can be accessed using

1. HTML View
You can usa the navigation links at the op of this page to explors the database.

2. RDF View

You can also explore this database with Semantic Web browsers like Tabulaior. To start
browsing, open this entry point UAL in your Semanlic Web browser:

httpiflocalhost-2020/al1
3. SPARQL Endpoint
SPARQOL clients can query the database at this SPARCL endpoint:
hitp/Nocalhost:2020/sparq!

The database can also be explored using this AJAX-based SPARCH, Explorsr.

Gwrmrntind fry [ flawrwpe

—_— ——
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10. MOLGENIS XML language reference

MOLGENIS is configured using an XML based language as described above. This chapter details

the semantics and use of each XML element and attribute that is defined in this XML language.
- for data model definition use entity , field , unique , and module elements.
- for user interface design use form , menu, and plugin  elements.

Below the Document Type Definition (DTD) that summarizes MOLGENIS XML structure:

<?xml version="1.0" encoding="UTF-8"? >
<IELEMENT molgenis ( description ? , ( module | entity | form | menu | plugin )*)>
<IATTLIST molgenis name CDATA#REQUIRED
<IATTLIST molgenis label = CDATA#IMPLIED >
<IATTLIST molgenis version CDATA #IMPLIED >
<IELEMENT description ANY>
<IELEMENT module ( description  ?, entity +)>
<IATTLIST module name CDATA#REQUIRED
<IELEMENT entity ( description ?, field *, unique *)>
<IATTLIST entity name CDATA#REQUIRED
<IATTLIST entity abstract ( true | false ) #IMPLIED >
<IATTLIST entity implements  CDATA#IMPLIED >
<IATTLIST entity extends CDATA#IMPLIED >
<IATTLIST entity decorator CDATA #IMPLIED >
<IATTLIST entity description CDATA #IMPLIED >
<I[ELEMENT field EMPT¥
<IATTLIST field name CDATA#REQUIRED
<IATTLIST field type CDATA#IMPLIED >
<IATTLIST field label =~ CDATA#IMPLIED >
<IATTLIST field length CDATA #IMPLIED >
<IATTLIST field xref field CDATA #IMPLIED >
<IATTLIST field xref_label CDATA #IMPLIED >
<IATTLIST field enum_options CDATA #IMPLIED >
<IATTLIST field default CDATA #IMPLIED >
<IATTLIST field auto( true |false ) #IMPLIED >
<IATTLIST field nillable ( true | false ) #IMPLIED >
<IATTLIST field unique ( true |false ) #IMPLIED >
<IATTLIST field readonly ( true | false ) #IMPLIED >
<IATTLIST field hidden( true |false ) #IMPLIED >
<IATTLIST field description CDATA#IMPLIED >
<IELEMENT unique EMPTY¥%
<IATTLIST unique fields CDATA #REQUIRED
<IATTLIST wunique subclass ( true |false ) #IMPLIED >
<IATTLIST wunique description CDATA #IMPLIED >
<IELEMENT form ( form *, menu*, plugin *)>
<IATTLIST form name CDATA#REQUIRED
<IATTLIST form entity CDATA #REQUIRED
<IATTLIST form label CDATA #IMPLIED >
<IATTLIST form view ( list |record ) #IMPLIED >
<IATTLIST form readonly ( yes| no) #IMPLIED >
<IELEMENT menu( form *, menu*, plugin *)>
<IATTLIST menuname CDATA#REQUIRED
<IATTLIST menu label CDATA #IMPLIED >
<IELEMENT plugin ( form *, menu*, plugin *)>
<IATTLIST plugin name CDATA#REQUIRED
<IATTLIST plugin  type CDATA#REQUIRED
<IATTLIST plugin label CDATA #IMPLIED >
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10.1. <molgenis> application definition ELEMENT

The <molgenis> element is the root of each MOLGENIS application definition file and can contain
data definition and/or user interface definition elements. The model can be split, i.e. there can be
multiple MOLGENIS XML files for one application (see section on molgenis.properties file).
Example usage of the <molgenis> element:
<molgenis name="nyfirstdb" label ="M/ First Database">

<menu name="nai nnenu" > ...

<entity name="firstentity"/>
<module name="mynodul e" />

</ molgenis >
Required attributes of the <molgenis> element:

¢ name="name": name of your MOLGENIS blueprint. This will be used by the generator to

name the java packages that are generated..

Optional attributes of the <molgenis> element:

« label="your label": Label of your MOLGENIS system. This will be shown on the screen as

well as heading in the generated documentation.

* Version="1.2.3": Version of your MOLGENIS system. It is recommended to use this to

manage the versions of your application.

The <molgenis> element can contain other elements:
« Exactly one <menu> or one <form> as main screen.
e Zero or one <description> elements describing the application
¢ Many <entity> elements describing the data structure.
* Many <module> elements describing the data structure. These are containers to group
<entity>.
10.2. <entity> data definition ELEMENT

The <entity> element defines the structure of one data entity and will result in a table in the

database, and several Java classes.
Example usage of the <entity> element:

<entity name="uni que_name" >

37



<description  >This is my first entity. </ description >
<field name="nane" type ="string"/>
<field name="i nvesti gati on" type ="string"/>
<unigue fields ="nane, i nvestigation"/>
</ entity >

Required attributes of the <entity> element:

« name="name": globally unique name for this entity (within this blueprint).

Optional attributes of the <entity> element:

« label="Nice screen name": an user-friendly alias to show as form header (default: copied

from name).

« extends="other_entity": you can use inheritance to make your entity inherit the fields of its

'superclass' using extends.

« abstract="true": you define what programmers call 'interfaces'. This are abstract objects

that you can use as 'contract’ for other entities to 'implement'..

« implements="abstract_entity": you can use inheritance to make your entity inherit the
fields of its ‘interface' using implements and refering to ‘abstract' entities. The

implemented fields are copied to this entity.

e decorator="package.class": you can add custom code to change the way entities are
added, updated and removed. See the section on how to write a MappingDecorator

plugin.

The <entity> element can contain other elements:
e Zero or one <description> to describe this entity; a description can contain xhtml.
e zero or more <field> that detail entity structure.

e Zero or more <unique> indicating unique constraints on field(s).

10.3. Advanced topic: using entity inheritance: extends and implements

MOLGENIS enables the use of the object-oriented mechanisms. Entities can extend on another

existing entity using the ‘extends="other_entity _name™ notation which means that all fields from

the other entity are added. Also abstract entities (interfaces) can be created using the

38



‘abstract="true™ attribute. Other entities can reuse these as reusable building blocks using the

‘implements="other_entity _name™ attribute.
Example usage of <entity .... extends= ...> syntax:

<entity name="bi cycl e" >

<description  >This my general entity </ description >
<field name="nane" type ="string"/>
</ entity >

<entity name="nount ai nbi ke" extends ="bi cycl e">
<description >

This type of bicycle has a name, but also number of gears
</ description >
<field name="nunber O Gears" type ="int"/>
</ entity >

10.4. <field> data definition ELEMENT
A field defines one property of an entity (i.e., a table column).
Example usage of the <field> element:

<field name="fi el d_nane"
description ="this is nmy first field of type string"/>

<field name="fi el d_nane" type ="autoi d"

description ="this is a id field, unique autonum integer"/>

<field name="fi el d_nane" type ="xref"
xref_field ="other_entity.id field"
description ="this is a crossrerence to otherentity"/>

<field name="fi el d_nane" type ="enun enum_options ="[optionl, option2]
description ="this is field of type enuni/>

Required attributes of the <field> element:
« name="name": locally unique name for this entity (within this entity).
« type="type": define the type of data that can be stored in this field, either:
0 type="string": a single line text string of variable length, max 255 chars.
o type="int": a natural number.
0 type="boolean": a boolean.
o type="decimal": a decimal number.

0 type="date": a date.
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0 type="datetime": a date that includes the time.
o type="file": attaches a file to the entity.
0 type="text": a multiline textarea of max 2gb.

o type="xref": references to a field in another entity specified by xref_field attribute

(required for xref). This will be shown as variable lookup-list.

o type="mref": many-to-many references to a field in another entity specified by
xref_field attribute (required for mref). This will be shown as multiple select

lookup-list. (Under the hood, a link table is generated)

o type="enum": references to a fixed look-up Ilist options, specificed by

enum_options attribute (required for enum)

Optional attributes of the <field> element:

label="Nice screen name": an user-friendly alias to show as form header (default: copied

from name).

unique="true": values of this field must be unique within the entity (default: "false")
nillable="true": this field can be left blank (default: "false")

readonly="true": this field cannot be edited once they are saved (default: "false")
length="n" (string only): limits the length of a string to 1<=n<=255 (default: "255").

xref_field="entityname.fieldname": specifies a foreign key to the entity and field that this

xref field must reference to, separated by ".' (default: required for xref)

xref_label="anotherfield": makes labels for the xref options based on one field of the

referenced entity (default: copied from xref_field).

enum_options="[valuel,value2]": the fixed list of options for this enum (required for

enum).

description="0ne line description": describes this field. This will be visibible to the user in

the Ul when (s)he mouses over the field or visits the documentation pages.

The <field> ELEMENT cannot contain other elements.
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10.5. <unique> data definition ELEMENT

A unique defines which properties of an entity (i.e., table columns) should be unique. There are

two ways to make a field unique.

1. A single column is unique. This example below shows that field "f1" is defined unique via
unique="true". This means that there cannot be two entity instances - two rows in table entityl -

with the same value “x” in the f1 column.

<molgenis name="exanpl e" >
<entity name="entityl">
<field name="f 1" unique ="true"/>
<field name="f 2" />
<field name="f 3" />
</ entity >
</ molgenis >

2. A combination of two or more columns is unique. The example below shows that the
combination of field “f1” and “f2” is defined as unique via the <unique> element. This means that
there cannot be two entity instances - two rows in table entityl - with the same value “x” in the f1
AND f2 column paired.
<molgenis name="exanpl e" >
<entity name="entityl">

<field name="f 1" />

<field name="f 2" />

<field name="f 3" />

<unique fields ="f1,f2"/>

</ entity >
</ molgenis >

Required attributes of the <unique> ELEMENT:
« fields="field1,field2": comma separated enumeration of the unique fields.

The <unique> ELEMENT cannot contain other elements.

10.6. <module> data definition ELEMENT

The <module> element allows designers to group entities in packages which will show up in the
generated documentation (and in future MOLGENIS also in the package structure). Example

usage:

<molgenis name="exanpl e" >
<module name="nodul el">
<description >This is my first module </ description >
<entity name="entityl">
<field name="f 1" type ="string" unique ="true"/>
<field name="f 2" type ="string"/>
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<field name="f 3" type ="string"/>

</ entity >

<entity name="entity2">
<field name="f 1" type ="string" unique ="true"/>
<field name="f 2" type ="string"/>
<field name="f 3" type ="string"/>

</ entity >

</ module >

</ molgenis >

10.7. <form> user interface ELEMENT

The <form> element is used to define a user element that shows the records of a certain entity on
screen (including insert, update, save, search, etc). A form may have tabbed (menu) or un-tabbed

(form) subscreens which are defined by nesting other user interface elements.

Example usage of <form> element:

<form name="mynane" entity ="nyentity">
<form name="nynane" entity ="mysubentity"/>
</ form >
<form name="mynane" entity ="nyentity" viewtype ="list" limit ="10"/>

Required attributes of the <form> element:
« name="name": locally unique name for this screen element (within its container).

« entity="myentity": which data entity will be loaded (i.e., points to a <entity

name="myentity"/>).

Optional attributes of the <form> element:

« label="Nice screen name": an user-friendly alias to show as form header (default: copied

from name).

« viewtype="record" or viewtype="list": whether the form should start with a list or per-

record (default: "record").
e limit="10": how many records must be shown in the list (default: "5").

< readonly="true": can the records be edited or is the form readonly (default: "false").
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The <form> element can contain other elements:
e Zero or more <menu> elements to denote subscreen(s).
e Zero or more <form> elements to denote subscreen(s).
e Zero or more <plugin> elements to denote subscreen(s).

Nested forms are automatically linked to the containing form based on foreign key (xref)

relationships.

10.8. <menu> user interface ELEMENT

The menu element allows the design of a hierarchical user interface with a menu on the left of the

user interface and/or in tabs for each contained subscreen (menu, form, plugin).
Usage example of the <menu> element:

<molgenis >
<menu name="my_mi nmenu" >
<form name="nyfirsttab" entity ="an_entityl" />
<menu name="rmy_submenu" >
<form name="myt hi r dt ab" entity
<form name="myf ourt hab" entity
</ menu>
</ menu>
</ molgenis >

"an_entity2" />
"an_entity3" />

Required attributes of the <menu> element:

« name="menuname": locally unique name for this screen element (within its container).

Optional attributes of the <menu> element:

e startswith="mysubelement": subscreen tab that is selected when menu is first shown

(default: first subscreen).

The <menu> element can contain other elements:
e Zero or more <menu> elements to denote subscreen(s).
e Zero or more <form> elements to denote subscreen(s).

e Zero or more <plugin> elements to denote subscreen(s).
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10.9. <plugin> user interface ELEMENT

The <plugin> element allows to plug-in custom screen elements into the MOLGENIS user

interface next to the auto-generated <form> and <menu> elements. The implementation of how to

write a plugin is described elsewhere.
Required attributes of the <plugin> element:
« name="name": globally unique name for this entity (within this blueprint).

« Type="package.path.ClassName”: reference to a java class in the ‘handwritten/java’

folder. Note: if this class doesn't exist than it will be automatically generated.

Optional attributes of the <plugin> element:

« label="Nice screen name": an user-friendly alias to show as form header (default: copied

from name).

The <plugin> element cannot contain other elements.
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